Version

9.1

Process, Records, and Information Management at Edwards
Basic Object Functions

[image: image28.jpg]Quick Reference
Guide





[image: image29.jpg]PriME
BSX




Basic Object Functions

PRIME/BSX Quick Reference Guide

David Yergensen – PRIME/BSX Instructor

TYBRIN Corporation

307 E. Popson • Building 1400

Edwards AFB, CA 93535

Phone 661.277.7244 • Cell 661.810.3848
Table of Contents

Chapter 1 - Navigation
1Tools menu


1Personal menu


1Enterprise menu


1Help menu


2Navigation drop-down list


2
 Up One Level icon


2
Functions icon


2Search bar


2Sort Item Information by Headings



Chapter 2 - Basic Object Functions
3Help


4Password Change


4Viewing the Properties of an Item


5Add a Folder


6Add a Document


7Add a Poll


7Edit a Poll


9Add a Text Document


10Add a URL


11Make an Alias


12Make Favorite


12Remove a Favorite


13Initiating a search from the Search bar


14Save Queries


15Save Search Results


16Search Display Options


19Modifying Notification Settings


20Modifying Notification Interests


20General Interests


20Specific Interests


21General Settings


22Color Settings


23Discussions Settings


24Workflow Settings


25Password Settings




 Chapter 3 – Document Revision Functions
26Summary of Document Revision Functions


27Reserve an Item


28Unreserve an Item


29Version Control


29Add a Version


30Set the maximum number of retained versions


30Purge existing versions


31Lock or unlock a version


31Delete a version


32View a version


32Fetch a version




This page was intentionally left blank
Chapter

1

Navigation

This chapter identifies the various ways to navigate through PRIME/BSX.
T
here are several menus, lists, and icons that help you navigate through PRIME/BSX easily and efficiently.

Tools menu 

This menu allows you to Search PRIME/BSX, log-out of PRIME/BSX, and modify your PRIME/BSX default settings. 

Personal menu 

This menu allows you to access various portions of your Personal Workspace, including your Personal Home, your Assignments page, and your favorites page, among others. 

Enterprise menu 

This menu allows you to access the Enterprise Home, Users and Groups, and the Livelink Explorer page. 

Help menu 

This menu allows you to access the PRIME/BSX Help Contents, view current page context-sensitive help, send feedback via e-mail to the PRIME/BSX staff regarding improvements or general comments about Help, and view the About PRIME/BSX page. 

Navigation drop-down list

You use the Navigation drop-down list to determine your precise position within PRIME/BSX.  For example, this list can indicate that you are within a particular folder contained within a specific project. The Navigation drop-down list appears in the upper left side of the workspace pages. 

[image: image3.png]


 Up One Level icon  

The Up One Level icon allows you to move up one level in the PRIME/BSX hierarchy.  For example, if you are in a folder within a project, clicking this icon will take you to the Project's home. The Up One Level icon is located to the immediate right of the Navigation drop-down list. 

[image: image4.png]


Functions icon 

Located next to every PRIME/BSX item, the Functions icon features a list of the operations that you have permission to perform on that specific PRIME/BSX item in its location. 

Search bar 

The Search bar is located at the top of most PRIME/BSX pages.  By typing a word or phrase in the Search field, you can locate an item stored at the current location or anywhere in PRIME/BSX. 

Sort Item Information by Headings 

When you click a column heading in PRIME/BSX, the information below it is sorted automatically according to the default setting for that heading. The default settings are primarily numerical or alphabetical, sorting items in descending or in ascending order.

Chapter

2

Basic Object Functions

This chapter identifies the basic function you can perform in PRIME/BSX.

Y
ou can perform various functions on PRIME/BSX items, depending on the item type and your permissions.  The operations you can perform appear when you click an item's [image: image5.png]


Functions icon:

	Help

	ACTION
	RESULT

	1. Click the on-line Help menu at the top right-hand corner of the page.  
	A drop-down menu will open.



	2. Click on one of the Help options

· Contents

· For This Page

· Send Feedback

· About
	A new web browser window opens and displays PRIME/BSX help related to the page you clicked

Displays PRIME/BSX Help Contents

View current page context-sensitive help

Send feedback via e-mail to the PRIME/BSX Administrator regarding improvements or general comments

View the About Livelink page

	3. Click the arrow next to a topic in the left frame.

OR
If a search field is displayed, enter some text to search for and click the Search button.
	The list of topics expands to display sub-topics for the item you clicked.

OR

A list of topics containing the text displays in the right frame.


	Password Change

	ACTION
	RESULT

	4. Click on Tools
	To open the Tools drop-down menu

	5. Click Settings
	The Settings page displays

	6. Select the Password tab and do the following:

· Enter your current password in the Current Password field

· Enter your new password in the New Password field

· Re-enter your new password in the Verify Password field


	The Password page displays

	7. Click the Update button
	A message will be displayed to notify you of a successful password change or error.


	Viewing the Properties of an Item

	ACTION
	RESULT

	8. Click the item’s [image: image6.png]


Function icon
	The item’s Function drop-down menu displays

	9. Click Info 
	The Info page’s drop-down menu displays

	10. Click on the property you wish to view

· General

· Specific

· Audit

· Categories

· Presentation

· References

· Versions
	The information corresponding to the property displays, and you can edit it if you have the permission.


	Add a Folder

	A folder is a container item that can hold any type of PRIME/BSX item, including another folder.  You use folders to organize items in PRIME/BSX, just as you do on your local computer.

To add a folder: 

	ACTION
	RESULT

	11. Go to the Folder in which you want to add a new Folder.
	The Add New Item menu appears in the top right of the browser page if you have the permission to add to this area.

	12. Click Folder on the Add New Item menu.
	The Add Folder page is displayed.

	13. In the Name field, replace "New Folder" with the name you want to give the Folder.
	The name of the Folder is displayed.  If no name is entered, PRIME/BSX will use New Folder in the Folder name.

	14. If you wish, use the Description text box to add additional information.
	This optional information is stored in the INFO area of the Folder, and you can use it when you search for the Folder.

	15. To modify the categories or attributes associated with the folder, click the Edit button.
	A window will open allowing you to select specific categories and/or attributes to associate to this object.

	16. Click the Add Item button.
	The new Folder is added to the location you choose.


	Add a Document

	You can add any type of file, with any extension (like .txt or .xls), from your computer to PRIME/BSX as a document.

To add a document:

	ACTION
	RESULT

	17. Go to the folder in the workspace in which you want to add a new Document.
	The Add New Item menu appears in the top right of the browser page - if you have the permission to add to this area.

	18. Click Document on the Add New Item menu.
	The Add Document page is displayed.

	19. In the Name text box, enter the name you want to give the document.
	If no name is entered, PRIME/BSX will use the file name of the document uploaded from your desktop

	20. If you wish, use the Description text box to add additional information (you can use this when you search for a document).
	This optional information is stored in the Info area of the Document, and you can use it when you search for the Document.

	21. To modify the categories or attributes associated with the document, click the Edit button.
	A window will open allowing you to select specific categories and/or attributes to associate to this object.

	22. If the path to the file on your desktop is known, you may enter the path in the File field of the Add Document page.  Go to Step 7.
	The path to the file on your desktop is displayed in the File field.

	23. To specify the location of the document on your desktop, click the Browse button, select the file and click OK.
	If the Browse button is chosen, a File Upload dialogue box is displayed requesting the location of the Document on your desktop.

NOTE: Depending on the browser’s default, you may need to change the List files of type: from “HTML files” to “All Files” (*.*).

PRIME/BSX returns to the Add Documents page.

	24. Click the Add Item button.
	The new document is added to the location you chose.


	Add a Poll

	You create Livelink polls to let your organization's Livelink user population vote on issues.

To add a Poll:

	ACTION
	RESULT

	25. Choose Poll on the Add New Item menu.
	The Add New Poll window appears.

	26. If desired, type a name for the poll in the Name field
	

	27. If desired, type a description of your poll in the Description field
	

	28. If desired, click the Edit button to modify the categories or attributes associated with the document.
	

	29. To place the item in a location other than that which appears in the Create In field, click the Browse Livelink button, navigate to the container where you want to locate your document, and click its Select link.
	

	30. Click the Add Item button.
	After you add the poll object to Livelink, you must edit it to create its contents.


	Edit a Poll

	Once you have created a poll, you can edit it to add or modify its content and settings. Editing a poll enables you to create a polling question, define how it is viewed by other users, and set dates during which the poll is active.

To edit a Poll:

	ACTION
	RESULT

	31. Click the poll object's Functions icon, and choose Edit.
	

	32. If desired, type a new name for the poll in the Name field.
	

	33. Type instructions for the poll in the Instruction field, if desired.
	

	34. Click the dates you want the poll to be active in the Effective Date and Expiration Date drop-down lists.
	Note: 
These dates are required. 



	35. Type the question(s) pertaining to the poll in the Poll fields. Use the [image: image7.png]


and [image: image8.png]


buttons to add or delete Questions, Choices, Choice Selections, and Rows.
	

	36. Click one of the following radio buttons in the Choice Selection area to determine how users cast their votes:

· Radio Button

· Check Box
	

	37. Select one or both of the following check boxes:

· Allow viewing the results before voting, which allows voters to see the polling results for the issue before submitting their vote.

· Allow anonymous comments, which allows voters to submit anonymous comments regarding the issue.
	

	38. If desired, click the Browse button in the Image section to select an image in Livelink to be displayed on the polling page.
	Warning: 
If you edit the poll after votes have been cast, a message warns you that all existing votes will be deleted when you save your changes. 



	39. Click the Save Changes button.
	


	Add a Text Document

	Livelink Text Edit allows you to create a document in plain-text format anywhere in Livelink that you have the Add Item privilege.

To create a new document with Text Edit:

	ACTION
	RESULT

	40. Choose Text Document on the Add New Item menu.
	The Add New Text Document window appears.

	41. Type a name for the document in the Name field, if desired.
	Tip: 
If you want Livelink to automatically name the document the same as its file name, leave the Name field blank. 



	42. If desired, type a description of your document in the Description field.
	

	43. Type the contents of the text file in the Text field.
	Warning: 
Netscape Navigator will not accept text files larger than 8 kilobytes. If you are using Netscape Navigator, any text that you enter beyond this limit will be lost when you add the document to Livelink. 



	44. If desired, click the [image: image9.png]


icon to spell-check your text.
	

	45. Click the type of text document in the MIME Type drop-down list.
	

	46. To modify the categories or attributes associated with the document, click the Edit button.
	

	47. To place the item in a location other than that which appears in the Create In field, click the Browse Livelink button, navigate to the container where you want to locate your document, and click its Select link.
	

	48. Click the Add Item button.
	


	Add a URL

	Add a URL to a PRIME/BSX location if you want to provide easy access to an external Web site or a PRIME/BSX location.

To add a URL:

	ACTION
	RESULT

	49. Go to the folder in the workspace in which you want to add a new URL.
	The Add New Item menu appears in the top right of the browser page - if you have the permission to add to this area.

	50. Click URL on the Add New Item menu.
	The Add URL page is displayed.

	51. In the Name field, replace "New URL" with the name of the URL.
	The URL name is displayed.  If no name is entered, PRIME/BSX will use “New URL” as the default name

	52. If you wish, use the Description text box to add additional information.
	The optional information is stored in the Info area of the URL, and you can use it when you search for the URL.

	53. To modify the categories or attributes associated with the URL, click the Edit button.
	A window will open allowing you to select specific categories and/or attributes to associate to this object.

	54. Enter the URL (Universal Resource Locator) in the URL field.
· For WWW sites, the http:// does not need to be retyped.

· For gopher or ftp sites, delete http:// and begin with the gopher:// or ftp:// prefix.
	The URL is displayed in the URL field.

	55. Click the Add Item button.
	The new URL is added to the location you chose.


	Make an Alias

	An alias is a pointer to an original PRIME/BSX item located in a different container.

To make an alias:

	ACTION
	RESULT

	56. Click the original item's [image: image10.png]


Function icon, and choose Make Alias.
	The Function icon drop-down menu appears to the right of the item’s name.

	57. In the Name field, replace "New Alias" with the name of the Alias.  It may be useful for you to end the name with the word "alias."
	The name of the Alias is displayed.  If no name is entered, PRIME/BSX will use “New Alias” as the default name.

	58. If you wish, use the Description text box to add additional information.
	This optional information is stored as part of the information of the Alias, and is useful in searching for the Alias.

	59. To modify the categories or attributes associated with the alias, click the Edit button.
	A window will open allowing you to select specific categories and/or attributes to associate to this object.

	60. To place the Alias in the desired location 

· In the Create In field, click the lower Browse PRIME/BSX button.

· Navigate to the container where you want to save the alias.

· Click the Select link.
	This will define the path to the desired location for the new alias.

	61. Click the Add Item button.
	The new Alias is added to the location you chose.


	Make Favorite

	You store shortcuts to the PRIME/BSX items that you work with frequently on your Favorites page.  You can make practically any item a favorite—workflow maps, projects, documents, folders, queries, discussion topics, task lists, tasks, channels, and news. 

You can modify the tabs and organize items on the Favorites page.  Add a favorite from the Projects, Reports, or News pages.

To make a favorite:

	ACTION
	RESULT

	62. Click the original item's [image: image11.png]


Function icon, and choose Make Favorite.
	The Function icon drop-down menu appears to the right of the item’s name.

A link to this object is automatically created and placed in your Favorites page – located in your Personal Workspace.


	Remove a Favorite

	To remove a favorite from the Favorites page:

	ACTION
	RESULT

	63. Choose Favorites on the Personal menu.
	The Favorites page – located in your Personal Workspace will be displayed.

	64. Navigate to the item you want to remove, click the item's Functions icon, and then choose Remove Favorite
	The Function icon drop-down menu appears to the right of the item’s name.


	Initiating a search from the Search bar

	Use PRIME/BSX’s advanced query language and search technology to retrieve the information that you need from your PRIME/BSX database.  You perform simple searches by typing a query in the search field on the PRIME/BSX search bar, which appears at the top of most PRIME/BSX pages.  You perform more, advanced searches by constructing complex queries using PRIME/BSX’s customizable search form on the PRIME/BSX Search page. 
By default, the PRIME/BSX search form contains a Full Text section where you specify basic search criteria.  You can also display the following search sections:

· Scope                        -    which allows you to specify the search slices to which your queries apply

· System Attributes   -    which allows you to query the default metadata that PRIME/BSX associates with items. PRIME/BSX assigns system attributes to all PRIME/BSX items.

· Category                   -    which allows you to query custom metadata. Custom metadata are the attributes that are associated with particular PRIME/BSX items.

· XML Types              -    which allows you to query the XML attributes and elements that PRIME/BSX Administrators publish in PRIME/BSX. XML attributes and elements are the regions in an XML DTD or a sample XML document.

	ACTION
	RESULT

	65. Enter a search term (such as a word or set of words) in the Search textbox.
	PRIME/BSX locates all information containing the search criteria you specified, filters it to omit any items you do not have permissions to see, and displays the results on the Search Result page.

	66. Leave "From Here" selected in the dropdown list, or choose another slice to change the scope of your search.
	

	67. Press the ENTER key or click the Search button.
	

	Operator
	Description

	Space (" ")


	OR

	Plus sign (+)

(Note: no space after the +)
	AND

	Quotes (")
	Exact phrase

	Minus Sign (-)

(Note: Space before but no space after the -)
	Exclude "but not"

	Asterisk (*)
	Wildcard


	Save Queries

	You save a query in the PRIME/BSX location where you want to run it most frequently.

· Access the queries that you save in a Project Workspace by choosing Reports on the Project menu. 

· Access the queries that you save in your Personal Workspace by choosing Reports on the Personal menu.

	ACTION
	RESULT

	68. Do one of the following:

· Click the Save Query button on the PRIME/BSX Search page.

· Click the Save Query button on the Search Result page.
	The Add Search Report page opens.

	69. On the Add: Query page, type a unique name for the query in the Name field.
	It is recommended that you use a Name that indicates something about the timeframe in which the report was created.

	70. To provide a description of the query on its General Info page, type descriptive text in the Description field.
	

	71. To modify the categories and attributes associated with this item, click the Edit button.
	

	72. Click the Browse Livelink button.  In the Select Container to Create In window…

· Go to the PRIME/BSX location where you want to save the query

· Then click the Select link in the Actions column of that folder or workspace.
	Your web browser opens a Select container “window”.

The Select Container window closes, and the path to the folder you selected is displayed in the Create In field.

	73. Click the Add Item button.
	The page showing the folder in which you save your Search Report is displayed.


	Save Search Results

	You save the results of a search that you perform in PRIME/BSX when you want to preserve the results that PRIME/BSX produced in response to a particular query at a particular time.  In PRIME/BSX, a set of saved search results is called a snapshot.
You save a snapshot in the PRIME/BSX location where you want to access it most frequently.

· Access the snapshots that you save in a Project Workspace by choosing Reports on the Project menu, and then clicking the Project Snapshots tab. 

· Access the queries that you save in your Personal Workspace by choosing Reports on the Personal menu, and then clicking the My Snapshots tab.  

When you add a snapshot item to PRIME/BSX, you go directly to the folder or workspace where you saved the snapshot in PRIME/BSX.  You can then view the search results in that PRIME/BSX folder or workspace.

  To save a page of search results:

	ACTION
	RESULT

	74. Click the Save Result button on a Search Result page.
	

	75. On the Add: Snapshot page, type a unique name for the snapshot in the Name field.
	

	76. To provide a description of the snapshot on its General Info page, type descriptive text in the Description field.
	

	77. To modify the categories and attributes associated with this item, click the Edit button.
	

	78. Click the Browse Livelink button.

· In the Select Container to Create In window, go to the PRIME/BSX location where you want to save the snapshot,

· Then click the Select link in the Actions column of that folder or workspace.
	

	79. Click the Add Item button.
	


	Search Display Options

	You can customize the appearance of PRIME/BSX’s Search Result page by setting display options. You can show or hide search result summaries and descriptions, show or hide key phrases, and specify the number of search results that PRIME/BSX displays on one page. You can also specify the columns of information that you want to display on the Search Result page.
If you want to remove the customizations that you make to the Search Result page, click the Revert To Default button at any time. The Revert to Default button restores the query's display options to the default system configuration.

To set display options:

	ACTION
	RESULT

	80. Do one of the following:

· Click the Display Options button on the PRIME/BSX Search page to customize the appearance of the Search Result page produced by the specified query.
· Click the Display Options button on a Search Result page to customize the appearance of the current search results.
	The Display Options page opens, listing the current display options.

	81. To display information about a search result, select the Show Summaries/Descriptions check box, and then click one of the following options in the drop-down list:

· Summaries Only

· Descriptions Only

· Summaries Preferred

· Descriptions Preferred

· Summaries & Descriptions
	Displays a summary for each search result, if available. PRIME/BSX automatically generates summaries based on the text in the document.

Displays a description of each search result, if available. Descriptions contain the text that PRIME/BSX users type in the Description field when they add items to PRIME/BSX.

Displays a summary for each search result, if available. If a summary is not available, PRIME/BSX displays a description of the search result.

Displays a description of each search result, if available. If a description is not available, PRIME/BSX displays a summary of the search result.

Displays a summary and description of each search result, if available.

	82. To display significant phrases that are associated with search results, select the Show Key Phrases check box.
	

	83. Click the number of results that you want to display on one page in the Number of Results drop-down list.
	

	84. In the Column Settings section, do the following:

· Select the check boxes in the Show column that corresponds to the type of information that you want to display on the Search Result page.

· Type numbers in the Column Order fields to specify the order in which PRIME/BSX displays the corresponding columns of information on the Search Result page.

PRIME/BSX arranges the columns from left to right by increasing values.  Set increments larger than one so that you can make adjustments later, if necessary.
	

	85. Click the Save button.
	


Notifications

You use Personal Notification Reports to keep up to date with activity in PRIME/BSX.  

For example:
Many PRIME/BSX users set Notification to notify them when a Task appears on their Assignments page, or when a document is added to a particular folder.  

Each Notification page contains three Notification Reports (Hourly, Daily, Weekly) that you can modify individually. You choose the frequency for each report, and the Interests each report monitors.

On your Personal Notification page, you can do the following: 

· View or Clear your Notification reports 

· Modify your Notification Report Settings

· Modify your Notification Interests 

When you modify your Personal Notification Interests and Settings, you override the group default reports.  

You set Livelink Notification reports by performing the steps in the following tables:

	Modifying Notification Settings

	ACTION
	RESULT

	86. Choose Notifications on the Personal menu
	

	87. Click the Modify Settings button. 

2.1 Click the tab of the report whose settings you want to modify (Hourly, Daily, Weekly).

2.2 Click the Modify Settings button.

2.3 Modify the fields that appear on the report, as follows:

Report Name

Behavior

E-mail Options

Times

Purge Options

(only appears on Project Notification Settings page)
	

	88. Click the Submit button.
	


Modifying Notification Interests

An Interest is a PRIME/BSX object or type of activity you want to monitor.  Areas of interest for Notification Reports are located throughout PRIME/BSX.

	General Interests

	Tracks certain types of activity, such as workflow status or adding versions.

	ACTION
	RESULT

	89. Choose Notifications on the Personal menu.
	The Personal Notifications page will be displayed.

	90. Click the Modify Interests icon.
	The Notifications interest page will be displayed.

	91. Select a report (None, Hourly, Daily, Weekly) for each of the General Interests you wish to receive notifications for.
	You will receive email notification reports based on selection settings made on this page.

	92. Click the Update button.
	Your selections and changes have been saved.


	Specific Interests

	Tracks activity relating to particular PRIME/BSX objects, such as your department's Work in Progress folder or the Task List in a project in which you participate.

	ACTION
	RESULT

	93. For an object that you wish to receive a Notification Report for - Click its [image: image12.png]


Function icon.
	The Function drop-down menu will be displayed.

	94. Choose Set Notification
	The Notification settings page will be displayed.

	95. On the Set Notification page, update your Interests by doing one of the following for each Interest:

· Click <None> in the drop-down list if you do not want to be notified of the event.

· Click the name (Hourly, Daily, Weekly) of the Notification Report in the drop-down list that you want to notify you of the event.
	

	96. Click the Update button.
	Your selections and changes have been saved.


Settings

The Settings page is used for setting various User Account defaults, and is divided into five convenient tabs:

· General
-
Select a default Start Page, “New” and “Modified” indicator duration
· Colors
-
Select default Header and Row colors
· Discussion
-
Select default Period (Yesterday, A Week Ago, A Month Ago, etc), View, Filter Preference, Posting Preference, Reply Preference, and View Item options
· Workflow
-
Assign/Delegate a Workflow Proxy and enable Auto Display of Next Task
· Password
-
Change the Password for your PRIME/BSX Account
	General Settings

	The General Settings page allows you to specify how long you want the New and Modified icons to display on your PRIME/BSX pages, and to specify which PRIME/BSX page appears when you log-in to PRIME/BSX.
To modify your general PRIME/BSX settings: 

	ACTION
	RESULT

	97. Choose Settings on the Tools menu.
	

	98. Click one of the following options on the Default Start Page drop-down list to change the page that appears when you log-in to PRIME/BSX:

· Enterprise Home

· Personal Home

· About Livelink
	Stores company-wide collaborative knowledge

Contains your personal folders and other PRIME/BSX items

Provides basic background information on Livelink's features and functionality

	99. Click a number in the [image: image13.png]


"New" Indicator Duration drop-down list.
	To set the number of days the new icon persists when a PRIME/BSX user adds a new item

	100. Click a number in the [image: image14.png]


"Modified" Indicator Duration drop-down list.
	To set the number of days the modified icon persists when a PRIME/BSX user modifies an item

	101. Click the Update button.
	This will save the changes made to the General settings


	Color Settings

	You can customize the appearance of Livelink by modifying the color scheme to suit your preferences.
To change your Livelink color settings: 

	ACTION
	RESULT

	102. Choose Settings on the Tools menu.
	

	103. Click the Colors tab.
	

	104. Click the radio button beside the color that you want to apply to the Column Header, Row 1, and Row 2.
	

	105. To see your selections, click the Preview button, and then click the Close button in the new window when you are done viewing your color scheme.
	

	106. Click the Update button.
	Saves changes made to the Color settings.


	Discussions Settings

	PRIME/BSX Discussions allow users to work together collaboratively to resolve issues and problems they encounter while working on projects.  The Discussion Settings page allows you to choose the time periods and views you see when you access a discussion.
To change your PRIME/BSX discussion settings:

	ACTION
	RESULT

	107. Choose Settings on the Tools menu.
	

	108. Click the Discussion tab.
	

	109. Click a time period in the Default Period From drop-down list.  PRIME/BSX displays items posted within the time period shown.
	

	110. Click one of the following options in the Default View drop-down list:
· Nested View 

· Report View 
	Displays replies indented below messages

Displays all messages and replies in a list format

	111. Click one of the following radio buttons to set what messages you view:
· Topics Only

· Unread Only

· All
	Displays discussion messages that introduce a new topic only

Displays only discussion messages you have not previously viewed

Displays all discussion messages

	112. Clear the Quote Comments check box if you do not want PRIME/BSX to automatically enclose your comments in quotation marks.
	

	113. Clear the Use Content Summary as Subject check box if you do not want PRIME/BSX to use an excerpt from the beginning of untitled topics and replies as the subject.
	

	114. Clear the Show Threads in Context check box if you do not want PRIME/BSX to display threads beside the topics and replies related to them.
	

	115. Click the Update button.
	Saves changes made to the Discussion settings.


	Workflow Settings

	PRIME/BSX Workflow allows PRIME/BSX users to create and participate in automatically executing work processes.  For example, a common workflow is initiated by an employee requesting vacation time.  A workflow proxy can complete workflow steps assigned to you if you are out of the office or otherwise unavailable.  In addition, if you have several tasks assigned to you in an executing workflow, you can choose to have PRIME/BSX display subsequent tasks automatically upon completion of a task, instead of retrieving each task individually. 
To change your Workflow settings: 

	ACTION
	RESULT

	116. Choose Settings on the Tools menu.
	

	117. Click the Workflow tab.
	

	118. To set your Workflow proxy, click the Choose User or Group icon [image: image15.png]


.
	

	119. In the Select Proxy window, click one of the following search areas in the Search drop-down list:
· User Last Name

· User First Name 

· User Log-in 

· User E-mail 

· Group Name 
	

	120. Type your search term in the for field.
	

	121. Click the Find button.
	PRIME/BSX performs a case-insensitive starts with search.  For example, typing van in the Last Name field displays information about PRIME/BSX users whose last name begins with van or Van.  A blank field retrieves all records of the type selected.

	122. Click the Select link of the PRIME/BSX user or group you want to act as your proxy when you are unavailable.
	

	123. To make PRIME/BSX automatically display the next task assigned to you in a workflow, select the Enable Auto Display of Next Task check box.
	

	124. Click the Update button.
	Saves changes made to the Workflow settings.


	Password Settings

	Passwords are case-sensitive and characters consist of letters, numbers, and special characters.  Only the first 16 characters of a password are significant; PRIME/BSX ignores the rest.  

· Forward slashes (/) are not allowed

· If you are unable to remember your password, contact your Livelink Administrator.

To change your password:

	ACTION
	RESULT

	125. Choose Settings on the Tools menu.
	

	126. Click the Password tab.
	

	127. Type your current password in the Current Password field.
	

	128. Type a new password in the New Password field.
	

	129. Re-type the new password in the Verify Password field.
	

	130. Click the Update button.
	Saves changes made to the Password settings.


Chapter

3

Document Revision Functions

This chapter identifies the various functions for controlling documents and their versions within PRIME/BSX.
W
hen you modify a workflow map, a document, or a compound document, PRIME/BSX adds the modified item as a new version, but retains a specified number of previous versions.  You always work with the most current version of an item by default.  You can view previous versions on the item's [image: image16.png]


 Versions Info page.
· You cannot add a new version to an item that is reserved by another user. 

· You can lock a version to ensure that PRIME/BSX retains it when a user purges versions or adds a version beyond the set limit. 

· PRIME/BSX does not include locked versions in the number of versions to be retained. 

· You cannot purge locked versions. 

	Summary of Document Revision Functions

	FUNCTION
	RESULT

	· Reserve

· Unreserve

· Version Control
	Write-locks the document in PRIME/BSX without copying it to your Desktop.

Unlocks a write-locked document in PRIME/BSX.

Provides a method to lock and/or retrieve previous versions of the document in Livelink, as well as a method for controlling the maximum number of versions.


	Reserve an Item

	When a team of PRIME/BSX users work with a particular item, it can be difficult to keep track of changes.  Thus, it is important to prevent multiple people from simultaneously revising a document.  You do so by reserving it.  Other PRIME/BSX users can still view, fetch, or download a reserved document, but they cannot reserve it or modify it.  Only the PRIME/BSX user who has reserved the document can unreserve it, or add a new version of it to PRIME/BSX.

When you reserve a document, you can also download a copy to your local computer. 

You can reserve documents, compound documents, and workflow maps. You must have the Reserve permission to reserve an item. 

To reserve an item: 

	ACTION
	RESULT

	131. Click the item's [image: image17.png]


Function icon and choose Reserve.  
	

	132. Click the name of the PRIME/BSX user or group you want to reserve the document in the Reserve By field.
	

	133. To save a copy of the document, do the following:

· Click the Download link.

· Browse to the location where you want to store the file in the Save As dialog box, and click the Save button. 
	

	134. Click the Submit button on the Reserve page.
	


	Unreserve an Item

	Unreserving an item removes the lock to allow other users access.  When you unreserve an item, you can add a new version of it to PRIME/BSX.

To unreserve an item:

	ACTION
	RESULT

	135. Click the item's [image: image18.png]


Function icon, and choose Unreserve.

136. To add a new version of the item, do the following:

· Select the Add New Version check box.

· Type information about the changes you made to the document in the Description field, if desired.

· Click the Browse button.

· In the File Upload or Choose File dialog box, browse to the document you want to add, click its name, and then click the Open button.

· To modify the categories and attributes for the document, click the Edit button. 
	

	137. Click the Submit button.
	


	Version Control

	To administer version control of a Livelink item, you can:

· Add a version

· Set the maximum number of retained versions

· Purge existing versions

· Lock or unlock a version

· Delete a version

· View a version

· Fetch a version


	Add a Version

	ACTION
	RESULT

	138. To add a version to a document in PRIME/BSX, click its [image: image19.png]


Function icon.
	The Function drop-down menu is displayed.

	139. Select Add Version from the Function drop-down menu.
	The Add Version page is displayed.

	140. If you wish, enter optional information about the new version in the Description text box.
	This information is displayed in the Description text box.

	141. Click the Browse button to locate the file on your desktop.
	The path is displayed in the Name field.  A File Upload dialogue box is displayed, requesting the location of the document on your desktop.

NOTE: Depending on the browser’s defaults, you may need to change the List files of type dropdown list from “HTML files” to “All types (*.*)”.

	142. Select the file on your desktop and click OK.
	The path is displayed in the File Upload field.  Livelink returns to the Add Version page.

	143. Click the Add Version button.
	The General INFO page is displayed.  The new version of the document is added, along with any descriptive information.


	Set the maximum number of retained versions

	ACTION
	RESULT

	144. Go to an item in PRIME/BSX and click on the item's [image: image20.png]


Function icon.
	The Function drop-down menu is displayed.

	145. Click the Info tab.
	This will open the Info drop-down properties menu

	146. Click the Specific tab.
	The Specific INFO page is displayed.

	147. In the Max.  Versions Field, replace "Unlimited" with the number of versions to keep.  Click Update.
	The browser page returns to the item’s location in Livelink.


	Purge existing versions

	ACTION
	RESULT

	148. Go to an item in PRIME/BSX and click on the item's [image: image21.png]


Function icon.
	The Function drop-down menu is displayed.

	149. Select Info.
	This will open the Info drop-down properties menu

	150. Select Versions.
	The Versions INFO page is displayed.

	151. Type an integer greater than 0 in the Versions to Keep field.  
	

	152. Click the Purge Versions button.
	

	153. Click the OK button in the confirmation dialog box.
	The browser page returns to the item’s location in Livelink.


	Lock or unlock a version

	ACTION
	RESULT

	154. Go to an item in PRIME/BSX and click on the item's [image: image22.png]


Function icon for which you want to lock a version, choose Info, and then choose Versions.
	The Function drop-down menu is displayed.



	155. Click the version's 

 Info icon.
	

	156. Click Lock (or Unlock) on the Functions menu.
	The Specific INFO page is displayed.

	157. Click Update.
	The browser page returns to the item’s location in Livelink.


	Delete a version

	ACTION
	RESULT

	158. Go to an item in PRIME/BSX and click on the item's [image: image24.png]


Function icon for which you want to lock a version, choose Info, and then choose Versions.
	The Function drop-down menu is displayed.

	159. Click the version's 

 Info icon.
	

	160. Click Delete on the Functions menu.
	

	161. Click the OK button in the confirmation dialog box.
	The browser page returns to the item’s location in Livelink.


	View a version

	ACTION
	RESULT

	162. Go to an item in PRIME/BSX and click on the item's [image: image26.png]


Function icon for which you want to lock a version, choose Info, and then choose Versions.
	The Function drop-down menu is displayed.

	163. Do one of the following:

· Click the version's Info icon, and then click View on the Functions menu.

· Click the version's name link.
	

	164. Click your browser's Back button when you finish viewing the version.
	


	Fetch a version

	ACTION
	RESULT

	165. Go to an item in PRIME/BSX and click on the item's [image: image27.png]


Function icon for which you want to lock a version, choose Info, and then choose Versions.
	The Function drop-down menu is displayed.

	166. Do one of the following:

· Click the version's Info icon, and then click Fetch on the Functions menu.

· Click the version's Fetch link.
	This will open the Info drop-down properties menu
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